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COMMVAULT® PROFESSIONAL ADVANCED COURSE LAB ACTIVITY GUIDE 

COMMVAULT® PROFESSIONAL ADVANCED 

The labs presented in this guide are designed to give you flexibility in completion. You may review the lab goals and 

explore on your own, or you may refer to the step by step directions to complete each lab. The labs are designed to be 

completed at the conclusion of each module to reinforce the information presented.  
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PRELIMINARIES 
 

Accessing the CVLab Environment  

 

Please follow the instructions below to access the CVLab environment: 

 

• Login to your Education Advantage Profile from https://ea.Commvault.com, to access your course materials and 

virtual lab environment. 

https://ea.commvault.com/
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Log in to the Virtual Lab Machines 

1. From your account in Education Advantage, navigate to the Courses Scheduled tab. 

2. Select this (Current course) course from the list. 

3. From the virtual Classroom screen. 

4. Click the link for CVLab V11. This will open popup window, the launchpad. Do not close this window, it is needed 

open for lab access. 

5. From the launchpad, power on the virtual machines in the following order. Wait for the status of the virtual 

machine to be at a “running” state before starting the next virtual machine. If any or all virtual machines are not 

running press , to start each one. 

a. EA-2019-MA 

b. EA-2019-CS 

c. EA-2019-HV 

6. Click the Connect  button for ea-2019-cs to download the RDP file that will access the virtual machine. 

Note: Some systems may only download a link and not start the RDP program. Click on the downloaded 

link to open RDP application and accept the security warning to continue. 

7. From The security popup window, enter the following credentials: 

a. Username: company\student (Should be prepopulated) 

b. Password: student 
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MODULE 1 - DEPLOYMENT 
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CommCell® Console 

Lab 1-1 Accessing the CommCell® Console 

In this lab, you will logon to the CommCell® Console. The goals for the lab are: 

• Access the ea-2019-cs virtual machine. 

• Log in to the CommCell® Console. 

If you are familiar with the Commvault CommCell Console, you may access the Console on your own. If you are new to 

Commvault, you can follow the step by step directions listed below. 

 

Accessing the CommCell Console 

1. From the taskbar, launch the CommCell Console Note that the CommCell console is also available from the 

Windows start menu under Commvault. 

2. From the Connect to CommCell popup window, log in using the following credentials: 

a. Username: admin 

b. Password: admin 

3. You will now be logged in to the CommCell Console. 

Lab 1-2 CommCell® Console Components 

In this lab, you will access and view the CommCell Console Components. The goals for the lab are: 

• View the features of the CommCell Console Toolbar. 

• View the features of the CommCell Console Browser window. 

• View the features of the CommCell Console Browser summary window. 
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• View the features of the CommCell Console Job Summary window. 

• View the features of the CommCell Console Event Viewer window. 

If you are familiar with the CommCell Console, you may access the Console on your own. If you are new to Commvault, 

you can follow the step by step directions listed below. 

 

The CommCell Console Toolbar 

1. Log in to the CommCell Console using the login information from the previous lab and navigate to the tab menu 

section at the top of the screen. 

2. Note on the Home tab the Items Web Console, Command Center, Health Status, and SLA Status, when selected 

will open in a web browser in a separate window. 

3. Click through the other tabs to see the available options. 

 

The CommCell Console Browser Window 

1. Log in to the CommCell Console using the login information from the previous lab and navigate to the CommCell 

Browser window. 

2. Expand Client Computers | ea-2019-cs | File System | defaultbackupset in the browser section. Note that as 

you expand each level, the contents from that level are viewed in the Browser Summary window. Subclients are 

only viewed in the Browser Summary window. 

3. Click the Agents view at the bottom of the Browser section. Note that they are arranged in containers by agent 

type, then listing the installed servers. 

4. Click the CommCell Browser at the bottom of the Browser section to return to the CommCell Browser view. 

 

The Content/Summary Window 

1. From the CommCell Browser window, click on the top entity. 

2. In the window frame next to the CommCell Browser, you will see three tabs. By default, the first tab on the left is 

the Browser Summary window. Note: these windows may not always be in this order.  

3. Click to highlight the Browser summary window (default content view) and note the information listed as it is the 

same containers listed in the browser section. 

4. Click the Client Computers Entity in the CommCell Browser window and watch the display change in the 

Summary tab. This gives an overview of base information about each client. 

5. At the bottom left of the Browser Summary window, click the Summary View tab. This view gives general 

overview of clients in the CommCell. 

6. Note that at the top of the window under the tab are links to each level of the path you have selected. Click the 

link for the top level (ea-2019-cs) and it will take you back to that point. 

 

The Job Controller Window 
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1. In the window next to the CommCell Browser, you will see several tabs.  Click to highlight the Job Controller 

window and note the information listed. If there are jobs running you will see summary information about each job 

listed. 

 

2. In the top bar of the Job Summary window is a section titled Views Click the + next to the views dropdown list to 

create a filter. 

3. In the Add Filter window, enter the following information: 

a. Name: VSA Backups 

b. Filtering Criteria: 

i. Select a Column: Agent Type 

ii. Condition: contains 

iii. Value(s): Virtual Server (From dropdown list) 

c. Click Add to List button. 

d. Make sure the radio button is selected for Match rows that contain ALL of the criteria. 

e. Click OK to create the filter. 

4. Click the filters drop-down list and select Show All Jobs to return to the default view. 

5. In the bottom left of the Job Summary window are Pause and Play buttons. The Pause button simply pauses the 

refresh for the Job Summary window. The Play button resumes refresh.  

 

NOTE: Pausing the Job Controller window does not pause the jobs themselves. It merely pauses the refresh of the 

window. 

   

The Event Viewer Window 

1. In the window next to the CommCell Browser, you will see several tabs.  

2. Click to highlight the Event Viewer window and note any information listed. Notice there are two sub tabs in the 

Event Viewer window, Focused Events and All Events. Click on the All Events tab to view all available events. 

3. From the All Events view, right click anywhere in the window and select Search Events menu option. 

4. From the Events Selection popup window, select and enter the following information: 

a. Create a search query: Select the Severity tab 

b. Select the type(s) of events to be viewed: Deselect Major so that only Critical is checked 

c. Save this search query as: Check the box. 

d.  Check the box next to Save this query as: and name the query Critical Events 

5. Click OK to save the query. This will save and run the query. This will display a popup window with the selected 

Event types.  

6. View the listed events and click the Close button with close the window and return to the Event Window. 

7. Once completed, you can run the query by right clicking anywhere in the window and selecting Search Events 

then selecting the query from the drop-down list. 
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8. Change the view back to Focused Events, and in the top right of the Event Viewer window is a section titled 

Focused Events in the Last: Click the up and down arrows to increase or decrease the number of days of 

events shown. Click Refresh to refresh the window. 

 

Lab 1-3 Customizing the CommCell® Console 

In this lab, you will customize the CommCell® Console. The goals for the lab are: 

• Hide the CommCell Browser. 

• Move tabbed windows. 

• Float tabbed windows. 

• Add and remove fields in the Job Controller. 

• View job details in the Job Summary window. 

• Run a Job and change job status. 

• Change the job status update interval. 

• Modify the Job Controller retention time. 

If you are familiar with Managing the CommCell Console, you may work through the lab goals on your own. If you are new 

to Commvault, you can follow the step by step directions listed below. 

 

   Hide the CommCell Browser 

1. Navigate to the CommCell Browser window. At the top of the Browser window, click the Pin . This will hide the 

CommCell Browser window on the left side of the screen. 

2. Move the mouse over the CommCell Browser tab to expand the screen out and click the Pin  to re-pin the 

CommCell Browser window. 

 

Move Tabbed Windows 

1. Navigate to the section of the CommCell Console with the Browser Summary, Job Controller and Event Viewer 

tabs. 

2. Click and drag the Job Controller tab to the first position on the left. 

3. Click and drag the Job Controller tab back to its original position. 

 

Float Windows 

1. Navigate to the section of the CommCell Console with the Browser Summary, Job Controller and Event Viewer 

tabs. 

2. Click the job Controller Tab to change to that view. 

3. In the top right of the Job Controller window, click the Float  option to float the window in the foreground. 

4. Click the Float  option from the Job Controller window to move the window back to its tabbed position. Note that 

the Job controller is now in a different position. Click and drag the tab to the center position. 
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Full Screen Windows 

1. Navigate to the section of the CommCell Console with the Browser Summary, Job Controller and Event Viewer 

tabs. 

2. Click the job Controller Tab to change to that view. 

3. In the top right of the Job controller window, click the Full Screen (full)  option to expand the window to full 

screen. 

4. Click the Full Screen (tabbed)  option from the Job Controller window to move the window back to its tabbed 

position. Note that the Job controller is now it the third position. Click and drag the tab to the center position. 

 

NOTE: You can unpin any of the tabs from this section the same way that you did for the CommCell Browser. Unpinning 

will move the tab to the left of the Console. Mouseover will expand the tab out and it can be repinned. 

 

Add, Resize and Remove fields 

1. Navigate to the section of the CommCell Console with the Browser Summary, Job Controller and Event Viewer 

tabs. 

2. Click the Job Controller tab to change to that view. 

3. In the top of the Job Controller window, note the fields listed. During a job, these fields are populated with job 

information. 

4. Click the line separating Client Co… and Agent Type (you should see a double-sided arrow) and drag to the 

right to expand the field. 

5. To add a field, click the double arrow  to access the dropdown list of options.  

6. Select Choose columns and then Schedule Policy Name. Click out of the dropdown menu to close it. 

7. Click and Drag the new column Schedule Police Name and place it between the Phase and Storage Policy 

fields. Click the line between Schedule Policy Name and Storage Policy and drag to the right to expand the field 

column size. 

8. To delete a field, click the double arrow  to access the dropdown list of options.  

9. Select Choose columns and then deselect Schedule Policy Name. Click out of the dropdown menu to close it. 

 

View Job Details 

1. From the CommCell Browser window, expand the Client Computer Container then highlight the ea-2019-cs client 

and navigate to the File System then defaultbackupset then Mission Critical subclient.  

2. Right click Mission Critical subclient and select Backup. 

3. Set the Backup type to Full and job initiation to Immediate. 

4. Click OK to start the backup job. 

5. Navigate to the Job Controller tab.  

6. Right click the Mission Critical backup job and select Detail…to view the job details. Note the information 

presented in each tab of the Backup Job Details For job ID:xxxx. Click OK to close the window. 
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Change job Status – Single job Control 

1. From the CommCell Browser window, expand the Client Computer Container then highlight the ea-2019-cs client 

and navigate to the File System | defaultbackupset | Mission Critical subclient.  

3. Right click Mission Critical subclient and select Backup. 

4. Set the Backup type to Full and job initiation to Immediate. 

5. Navigate to the Job Controller tab.  

6. Right click the Mission Critical backup job and select Suspend to suspend the job. Click Yes from the Warning 

popup window. 

 

Note: If the job is still in the Job Controller tab, you may right click the job and select Resubmit Job. Leave the job 

settings the same and Click OK to run the same job again  

 

Change Job Status – Multi-Job control 

1. Navigate to the Job Controller tab.  

2. Right click the previously suspended Mission Critical backup job and select Multi-job control. 

3. From the Multi-job Control Dialog window, enter the following information: 

a. Action: Click the Resume radio button. 

b. Selection: All Jobs 

4. Click OK to resume the job. You will see the job immediately resume. 

 

Modify the Job Controller retention Time 

1. On the Ribbon Bar menu at the top of the CommCell Console, select the Tools tab. 

2. From the Tools ribbon bar, select User Preferences.  

3. From the User Preferences popup window, select the Jobs tab. 

4. Under the Status retention in Job Controller of killed/Failed/Completed Jobs section, change the Retention 

Time (Secs) value to 1500. This will set the job retention time in the Job Controller window from 5 to 15 minutes. 

5. Click OK to set the retention value and close the popup window. 

 

Changing the job Update Status Interval 

1. On the Ribbon Bar menu at the top of the CommCell Console, select the Configuration tab. 

2. From the Tools ribbon bar, select Job Management.  

3. From the Job Management popup window, select the Job Updates tab. 
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4. Under the Job Update Interval section, Scroll and highlight to select Windows File System. Change the 

Protection (Mins) value to 2. This will set the job updates in the Job controller window to either 2 minutes, or the 

next checkpoint in the job. 

5. Click OK to close the window and set the Job Update interval value. 

 

 

Set Event Log Retention  

1. On the Ribbon Bar menu at the top of the CommCell Console, select the Tools tab. 

2. From the Tools ribbon bar, select User Preferences.  

3. From the User Preferences popup window, select the Event Filter tab. 

4. Deselect the checkbox Use Global Settings. Enter the following information: 

a. Maximum number of events in Event Viewer: 300 

b. Maximum number of days in Event Viewer: 5 

c. This will set the total number of viewed events from the event log to 300 events or 5 days of events. 

5. Click OK to save the event log retention settings.  

 

 

At the end of this lab, you will have completed the following: 

• Hide the CommCell Browser. 

• Move Tabbed Windows. 

• Float Windows. 

• Full Screen Windows. 

• Add, Resize and Remove fields. 

• View Job Details. 

• Change job Status – Single job Control. 

• Change Job Status – Multi-Job control. 

• Modify the Job Controller retention Time. 

• Changing the job Update Status Interval. 

• Set Event Log Retention. 
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Commserve® Server Installation 

Lab 1-4 CommServe® Server Post Installation Tasks 

Once the CommServe Server is installed, you can complete post installation tasks in the CommCell® Console. In this lab, 

you will complete the following tasks: 

• Configure the Software cache. 

• Configure a Remote Software Cache. 

• Populate the Software Cache. 

• View or modify Automatic Update Schedules. 

• Install Updates. 

• Enable Private Metrics Reporting. 

• Configure Email Settings. 

If you are familiar with the Commvault CommCell® Console, you may configure post installation tasks on your own. If you 

are new to Commvault, you can follow the step-by-step directions listed below. 

 

Configure the Software cache 

1. On the Ribbon Bar menu at the top of the CommCell Console, select the Tools tab. 

2. From the Tools ribbon bar, select Add/Remove Software.  

3. From the Add/Remove Software drop-down list, select Software Cache Configuration. 

4. From the CommServe Software Cache tab, note the location of the Software Cache. The cache can be moved 

by changing the cache location and copying the contents to the new location. 
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NOTE: If you move and manually copy the software cache contents you must perform a “Commit Cache” 

operation before the cache can be used for push install. 

5. Click the Cache Details button to view the current contents of the cache. Click OK to close the Cache Details 
window. 

6. To delete the cache contents, click the Delete Cache Contents button.   

a. Select the Delete All checkbox then click the Delete button. 

b. Type Delete in the Delete Cache Contents Confirm popup box. 

c. Click OK on the Selected cache operation was successful popup window. 

7. Click OK when you are finished to close the window. 

 

Configure a Remote Software Cache 

1. On the Ribbon Bar menu at the top of the CommCell Console, select the Tools tab. 

2. From the Tools ribbon bar, select Add/Remove Software.  

3. From the Add/Remove Software dropdown list, select Software Cache Configuration. 

4. From the Software Cache Configuration popup window, Click the Remote Software Cache tab.  

5. From the Remote Software Cache tab, click Add to add a remote cache. 

6. From the Configure Remote Software Cache popup window, enter the following information: 

a. Computer: ea-2019-ma (From dropdown list) 

b. Enable Remote Software Cache: Checked 

c. Please Specify Cache Directory: Click Browse 

i. Navigate to J:  

ii. Click New Folder and name the folder SoftwareCache, click OK to continue. 

iii. Select (Highlight) the new folder SoftwareCache and click OK to set it as the remote cache 

location 

d. Click the Configure Packages to Sync button. 

e. From the Configure Packages to Sync popup window, select Customize Packages. 

f. In the lower section of the popup complete the following information: 

i. Select OS box, use the dropdown menu and select Windows(x64). 

ii. Click In the next box and check box under: 

1.  Microsoft Windows: select File System, File System Core.  

2. Server: select MediaAgent. 

3. Virtualization: select Virtual Server, VSA Guest Customization. 

iii. Click OK to save selection from Configure Packages to Sync window. 

g. Click OK in the Configure Remote software Cache window to create the cache. 

7. Click Ok to save and close the Software Cache Configuration window. 
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NOTE: You may also click the Add/Remove Clients button to add specific clients or groups to be updated using 

this cache. This will override the CommServe Cache default setting. 

 

Populate the Software Cache 

1. In the Ribbon Bar menu at the top of the CommCell Console, select the Tools tab. 

2. From the Tools ribbon bar, select Add/Remove Software.  

3. From the Add/Remove Software dropdown list, select Download Software. 

4. From the Download and Sync Cache Options popup window, Click the Service Pack radio button and select the 

following information from the dropdown lists: 

a. Feature Release: 11.24 

b. Maintenance Release: 7 

5. Click OK to start the download.  

6. Click the Job Controller tab to view the download progress. 

 

View or modify Automatic Update Schedules 

1. In the CommCell Browser window, select the top entity in the tree, Right Click on the CommCell root (ea-2019-

cs). From the menu select View and then Schedules. 

2. From the Schedules tab that opens, locate and select System Created Download Software. 

3. Right Click on System Created Download Software and select Edit. 

4. In the Download and Sync Cache Options popup window, change the time to 6:00 pm. 

5. Click OK to set the schedule time.  

6. Click the X on the Schedules tab to close the tab. 

 

Install Updates 

Note: Wait for the download of the updates to complete before you continue.  

1. In the CommCell Browser window, navigate to Client Computer Groups. 

2. Expand Client Computer Groups and right click on the Infrastructure group. Select All Tasks, then 

Add/Remove Software, then Update Software. 

3. From the Update Software Options popup window, leave the default settings and click OK to start the update. 

4. From the warning popup window Click OK to acknowledge the commcell update warning. 

5. Click the Job Controller tab to view the install progress. 

6. Locate the Install Updates job, right click on the task and from the menu select Detail... 

7. From the Install Updates Job Details popup window, click on the Client Status tab to view details. 

8. Click OK to close the job details window. 

 

NOTE: In this lab, the hotfix install will complete successfully with the status “Already updated”. This is because we 

haven’t downloaded any new Hotfix packs. Also, some of the clients that are currently offline may show as failed to 

update. 
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Enable Private Metrics Reporting 

1. In the Ribbon Bar menu at the top of the CommCell Console, select the Home tab. 

2. From the Home ribbon bar, select Control Panel.    

3. From the Monitoring section, select Private Metrics Reporting. 

4. From the Private Metrics Reporting popup window General tab, enter the following information: 

a. CommCell diagnostics and Usage: Click the Checkbox and check - Health check, Activity, Audit 

b. Chargeback: leave unchecked 

c. Metrics Server URL: http://ea-2019-cs.company.com/webconsole/ 

5. View the options in the Configuration tab. Leave the default settings in these tabs. 

6. Navigate back to the General tab and click the Upload Now button to upload metrics information. 

7. If prompted, Click Yes to save changes and upload now.  

8. Click OK to exit the Private Metrics Reporting window. 

9. From the Monitoring section, select Private Metrics Reporting. 

10. Note that the last collection and upload times are now listed (This may take a few minutes). Click OK to save the 

configuration and exit the popup window. 

11. Click the X in the top right corner of the Control Panel window to exit.  

 
 
Configure Email Settings 

1. Log in to the CommCell Console. 

2. In the Ribbon Bar menu at the top of the CommCell Console, select the Home tab. 

3. From the Home ribbon bar, select Control Panel.    

4. From the Maintenance section of the Control Panel, select Email, Web, and FTP Server. 

5. From the Email, Web, and FTP Server popup window E-Mail Server tab, enter the following information: 

Server Information 

a. Mail Server: EA-2019-EXCH 

b. Mail Server Port: 25 

c. Mail server size limit (MB): 5.0 

Sender Information 

a. Sender Name: Commserve 

b. Sender Address: cvadmin@company.com 

7. Click OK to set the Email server information and close the Email, Web, and FTP Server popup window. 

 

At the end of this lab you will have completed the following items: 

• Configured the Software cache. 

• Configured and updated a Remote Software Cache. 

• Populated the Software Cache. 

• Viewed and modified Automatic Update Schedules. 
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• Installed Updates. 

• Enabled Private Metrics Reporting and uploaded Metrics information. 

• Configured Email Settings. 

 

Lab 1-5 CommServe® Server Maintenance 

An integral part of managing a CommCell is running maintenance functions and potentially, CommServe Server recovery. 

In this lab, you will complete the following tasks: 

• Log in to the CommCell Console. 

• Run dbmaintenance from the command line. 

• Execute the dbmaintenance workflow from the CommCell Console. 

• Recover the CommServe Server Database. 

• Customize the Command Center layout. 

If you are familiar with the Commvault CommCell® Console, you may run maintenance routines and CommCell recovery   

on your own. If you are new to Commvault, you can follow the step by step directions listed below. 

Database Maintenance using DBMaintenance (Command Line) 

1. Log into the ea-2019-cs virtual machine. 

2. Click the windows Icon and navigate to Windows System. Expand the Windows System section and right click 

Command Prompt. Select More then Run as administrator. 

3. Click Yes from the User Account control screen. 

4. In the command prompt, type in dbmaintenance and review the maintenance options. 

5. Type in dbmaintenance -recommended to run the dbmaintenance function with the recommended settings. 

6. View the information on consistency check and index reorganization and defragmentation. 

7. Close the Command prompt when the maintenance task is complete. 

 

Database Maintenance using DBMaintenance (Workflow) 

1. Log into the CommCell Console. 

2. In the CommCell Browser, navigate to and click the Workflows entity. 

3. From the list of workflows in the Browser Summary window, right click on the DBMaintenance workflow and 

select All Tasks then Execute. 

4. From the DBMaintenance Options popup window, navigate to the type* dropdown list and select 

Recommended. 

5. Click OK to run the dbmaintenance workflow. (the default job initiation is to run immediately) 

6. Click the Job Controller tab to view the job progress. 

 

CommServe Recovery Assistant 

1. In the CommCell Browser section, navigate to and click the ea-2019-cs root entity. 



V11 FR22 Commvault Professional Advanced Lab Activity Guide March 2021 

Page 22 of 61  Commvault® Education Services    

2. Right click on ea-2019-cs and select All Tasks, then Disaster Recovery Backup. 

3. From the Disaster Recovery Options popup window, select Full. Leave all databases selected and click OK to 

start the DR backup. 

4. Click the Job Controller tab to monitor the DR backup job. 

5. Once the DR Backup job completes. Click the X in the top right of the CommCell Console to close it. 

6. Open windows File Explorer and navigate to \\ea-2019-ma\CSDR.  

7. Select to the most recent SET_xxx folder (The date/Time of the job you just ran) and copy the folder to  

This PC\Documents. (on ea-2019-cs) 

8. From the File Explorer, navigate to C:\Program Files\Commvault\ContentStore\Base. 

9. From the base directory, locate the program CSRecoveryAssistant.exe and execute it. 

10. You may be prompted by User Access Control screen, Click Yes. 

11. From the CommServe Recovery Assistant screen, select Recovery/Production and click Next. 

12. To enter the database dump folder, click Browse and browse to This PC\Documents\Set_xxx. Click OK to 

select folder, then Click Next to continue. 

13. View the Database files and log files paths. We haven’t changed the path so this will remain as default. Click 

Next. 

14. View the summary of options selected and click Start Recovery. This will take several minutes to run through the 

recovery process.  

15. Once the recovery is complete (All green checks) click Next. 

16. License file is not needed for post recovery so click Next. 

17. From the CommServe recovery completed successfully!! screen, click Finish to complete the recovery. 

18. From the Windows Taskbar at the bottom of the screen, click the Process Manager Icon  to open the 

Commvault Process Manager. Click Yes on the User Account Control screen. 

19. From the Process Manager, click the Services Tab. Highlight and click the Green Start  button at the bottom of 

the screen. 

20. Once all the services have started, close the Process Manager and log into the CommCell console. 

 

NOTE: After a CommServe recovery, a DR Backup will run automatically. 

 

At the end of this lab you will have completed the following items: 

• Configured and run DBMaintenance from the command line. 

• Configured and run DBMaintenance from a workflow. 

• Perform a CommServe recovery. 
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MediaAgent Installation 

Lab 1-6 MediaAgent Installation 

Installing MediaAgents is an important part of CommCell deployment and function. MediaAgents must be installed and 

configured before Libraries are created. In this lab, you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Install MediaAgent software. 

• Configure the Index directory. 

• Set throttling rules. 

• Mark a MediaAgent offline for maintenance. 

If you are familiar with the Commvault CommCell® Console, you may Install and configure MediaAgents on your own. If 

you are new to Commvault, you can follow the step by step directions listed below. 

Push Install for the MediaAgent Software 

1. From your CVLab Launchpad window, verify that the EA-2019-HV virtual machine is running. 

2. Log in to the CommCell Console. 

3. In the Ribbon Bar menu at the top of the CommCell Console, select the Tools tab. 

4. From the Tools ribbon bar, click on Add/Remove Software and select Install Software from the menu.  

5. From the Install wizard screen, click Next. 
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6. From the Select the computer’s operating system screen, Select Windows and click Next. 

7. From the Select how to discover the computers for installing the software screen, select Manually select 

computers and click Next. 

8. From the Enter the hostnames of the computers screen, click in the white space under Please enter the 

names of the computers, one per line, type ea-2019-hv 

9. Click Next. 

10. From the Select Software Cache window, leave the default setting and click Next. 

11. From the Enter Account Information window, enter the following information: 

a. User Name: company\student 

b. Password: student 

c. Confirm Password: student 

12. Click Next to continue. 

13. From the Select Package(s) to Install window, check the box for the MediaAgent package and click Next.    

14. From the Enter Recommended Settings for the Selected software page, leave Client Groups and Storage 

policy blank.Click Next. 

15. From the Enter Additional Install Options window, review the available options, leave default settings, and click 

Next. 

16. From the Optional Settings window, review the available settings. Leave the settings on default and click Next. 

17. From the Network Route Configuration window, review the available options, leave default settings, and click 

Next. 

18. From the Please Select When To Run The Job window, leave the default setting (Immediate) and click Next. 

19. From the Summary window, review the selected install options and click Finish to start the installation. 

20. Click the Job Controller tab to monitor the install progress. 

 

Configure the Index Directory and Change the Index Location 

1. In the CommCell Browser window, click to expand the Storage Resources, then expand MediaAgents 

container. 

2. Right click on ea-2016-hv and select Properties from the menu. 

3. From the MediaAgent Properties for ea-2016-hv, click the Catalog tab. 

4. From the Catalog tab, change the Index Directory to D:\Indexcache. 

5. Click OK to change the index location and return to the CommCell Console. 

 

NOTE: After changing the index location, the system will copy the index to the new location. You will see it run as 

a job in the Job controller. 

 

Set Network Throttling Rules 

1. In the CommCell Browser window, click to expand the Storage Resources, then expand MediaAgents. 

2. Right click on ea-2016-hv and select Properties. 

3. From the MediaAgent Properties for ea-2016-hv, click the Network Throttle tab. 
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4. Check the box Enable Network Throttling. And enter the following information: 

a. Remote clients or client Group: Check the box for Laptop Clients. 

b. All clients share allocation bandwidth: Checked 

c. Throttling Schedule: Click Add and add the following information: 

i. Days of week: Monday – Friday (From Throttling Rule dropdown list) 

ii. Time Interval: Whole Day 

iii. Throttling Rate: Throttle Relative to Bandwidth, Check both send and receive boxes 

iv. Click OK to set the throttling rule 

5. From the MediaAgent Properties for ea-2016-hv, Click OK to save the throttling rule and return to the CommCell 

Console 

   

Mark MediaAgent Offline for Maintenance 

1. In the CommCell Browser window, click to expand the Storage Resources, then expand MediaAgents. 

2. Right click on ea-2016-hv and select Properties. 

3. From the MediaAgent Properties for ea-2016-hv, click the Control tab. 

4. From the Control tab, Check the box Mark MediaAgent Offline for Maintenance.  

5. Click OK to close window and return to the CommCell Console. 

 

NOTE: The Icon for ea-2016-hv will change in the CommCell Browser to indicate that the MediaAgent is offline. 

 

At the end of this lab you will have completed the following items: 

• Installed MediaAgent software. 

• Configured an Index location for a MediaAgent. 

• Configured Network Throttling rules for clients connecting to a MediaAgent. 

• Marked a MediaAgent offline for maintenance. 

 

DR B 
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Agent Installation 

Lab 1-7 Agent Installation 

Like the MediaAgent installation, installing client agents on new servers is a vital component of daily operations in a 

CommCell. In this lab, you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Install and Agent on a client using and interactive installation. 

If you are familiar with the Commvault installation process, you may run the installations on your own. If you are new to 

Commvault, you can follow the step by step directions listed below. 

 

Interactive Installation 

1. From your CVLab Launchpad window, verify that the EA-2019-HV virtual machine is running. 

2. Click on the download icon to connect to the EA-2019-HV VM. 

3. Login to the EA-2019-HV system using the following credentials: 

a. User Name: company\student (Pre-populated) 

b. Password: student 
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4. On the EA-2019-HV server, click on the Windows Start icon to open the Start Menu. Then select the Windows File 
Explorer tile and navigate to path \\ea-2019-cs\SW\CVMedia\11.0.0\ SP24_3589820_R952\Windows and double-
click Setup.exe. 

5. Select Yes to the pop-up window for User Account Control to allow the install to run. 

6. When the Commvault® Setup wizard appears, Click the default option for English and click > to continue.  

7. Check the checkbox next to “I Agree” to accept terms in the license agreement and click > to continue. 

8. At the Choose the Installation type screen, accept the default of Install packages on this computer and click 
> to continue. 

9. From the Install Option Screen, select the Add Packages option and click > to continue. 

10. From the Select Packages screen, select Virtualization on the left of the screen, then click the box next to 
Virtual Server. Click > to continue. 

11. Review settings for the Installation Summary screen, then click > to continue. The installation will begin. 

12. When the install is completed, click Finish from the Success screen. 

 

At the end of this lab you will have completed the following items: 

• Installed Agent software using an interactive installation. 
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Encryption 

Lab 1-8 Encryption 

In this lab you will configure Encryption to be applied in line with the data stream.  Inline encryption is configured in two 

areas.  The first is to enable it in the advanced properties of the Client system, then verify the encryption settings at the 

subclient level. In this lab, you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Configure In-Line encryption. 

• Configure copy-based encryption. 

• Configure Hardware encryption. 

• Set a Media Password for the CommCell and a Storage Policy. 

If you are familiar with the Commvault CommCell® Console, you may configure encryption on your own. If you are new to 

Commvault, you can follow the step by step directions listed below. 

In-Line Encryption 

1. In the CommCell® Browser, expand Client Computers. 

2. Right-click on ea-2019-cs and select Properties. 

3. In the Client Computer Properties for ea-2019-cs dialog box, click the Advanced button.  

4. Select the Encryption tab and select the Encrypt Data with the following settings radio-button. Enter the 
following information: 

a. Data Encryption Algorithm:  

i. Cipher: From the drop-down box select AES (Rijndael). 
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ii. Key Length: From the drop-down box, select 256. 

b. Direct Media Access (External Restore Tools): Via Media Password 

5. Click OK to save encryption settings to the Advanced Client Properties. 

6. Click OK to close the Properties page. 

 

Configure Subclient Encryption Options 

1. In the CommCell Browser, expand Client Computers then ea-2019-cs, File System, defaultbackupset.  

2. Right-click on the default subclient and select Properties. 

3. Click the Advanced button.  

4. In the General tab from the Encryption sub tab ensure the default encryption option is set to Network and 
Media (Agent Side).  If it is not, change the settings to Network and Media (Agent Side). 

5. Click OK to exit the Advanced Subclient Properties page. 

6. Click the Storage Device tab and select Basic Disk (MA) from the Storage Policy drop-down list. 

7. Click OK to exit the Main Properties page. 

 

Offline (Copy Based) Encryption 

1. In the CommCell Browser, expand Policies, then Storage Policies, then Basic Disk (MA). 

2. Right-click on Basic Disk (MA) and select All Tasks then Create New Copy. 

3. Select/Enter the following information for the new secondary copy wizard. Select Next after each section: 

4. From the Copy Details window: 

a. Copy Name: Daily Offsite Copy 

i. Storage Pools: Click Add, then select Disk 

1. Storage pool name: Daily Offsite DASH Pool then Next > 

2. Configure Storage:  

a. Create Local: Select ea-2019-ma from dropdown list 

b. Path: Browse and enter the following: 

i. Select Drive E: 

ii. Click the New Folder button  

iii. Enter the folder name ProdVol-2, then click OK 

iv. Highlight the new folder ProdVol-2, then click OK to close the 

Browse for Metada Directory window. 

3. Click Next > 

4. Enable Deduplication on Storage Pool: Check Enable Deduplication Box (Default) and 

enter the following: 

a. Number of Partitions: 1 

b. Choose Path (Partition 1):  

i. MediaAgent: ea-2019-ma 

ii. Partition Path: Browse to H: 

1. Click New folder, name it DashpoolDDB. Higlight the new 

folder DashPoolDDB, then click OK 

iii. Click OK to create DDB Directory 

c. Click OK to create the Partition Path 
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5. Click Next > 

6. Software Encryption: Check the box and enter the following: 

a. Cipher: Blowfish 

b. Key length: 128 

7. Click Next >. 

8. Client Group: Leave blank and click Next >. 

9. Review Selections and click Finish. 

b. From the Copy Details window, select the newly created Daily Offsite DASH Pool from the dropdown 

list and click Next >. 

c. From the Retention Rules window, leave the default retention 30 days and 1 cycle. Click Next > 

d. From the copy Policy window, Deselect All backups under Backup Selection and leave the default for 

Backups on and After. Leave all other setting on their defaults.  

e. Click Finish to create the encrypted Secondary Copy. 

 

Hardware Encryption 

1. In the CommCell Browser, expand Policies, then Storage Policies, then Basic Disk (MA. 

2. Right-click on Basic Disk (MA) and select All Tasks then Create New Copy. 

3. From the Copy Details window: 

a. Copy Name: Monthly Tape Copy 

i. Storage Pools: Click Add, then select Tape 

1. Storage pool name: Monthly Offsite Tape Pool then Next > 

2. Configure Storage:  

a. Storage Name: Commvault Scalar i6000 x 

3. Select the default MediaAgent and drive pool: 

a. MediaAgent: ea-2019-ma 

i. Drive Pool: DrivePool(ea-2019-ma)x 

ii. Click Next >  

iii. Scratch Pool: Default Scratch  

iv. Click Next > 

4. Enter the streams and retention criteria: 

a. Number of Device Streams: 6 

b. Primary Copy’s Aging Rules: 30 Days, 1 Cycle 

c. Click Next > 

5. Advanced Settings: 

a. Hardware Compression: Enabled  

b. Encryption Settings: Check box and enter the following: 

i. Hardware Encryption: Enable check box 

6. Click Next > 

7. Review your Selections: Click Finish. 

b. From the Copy Details window, select the newly created Monthly Offsite Tape Pool from the dropdown 

list and click Next >. 

c. From the Retention Rules window, leave the default retention 30 cycles and 1 day. Click Next > 

d. From the copy Policy window, Enter the following: 

i. Selective Copy: Leave at default Monthly Fulls and for each time period copy the First Full  

ii. Deselect All backups under Backup Selection and leave the default for Backups on and After. 

Leave all other setting on their defaults.  

e. Click Finish to create the encrypted Secondary Copy. 

    

Setting a Media Password - CommCell 

1. In the Ribbon Bar menu at the top of the CommCell Console, select the Home tab. 
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2. From the Home ribbon bar, select Control Panel.    

3. From the CommCell section of the Control Panel, select System. 

4. From the System window, select the Change Password tab. 

5. From the Change Password tab, check the box for Change media Password, and enter the following information: 

a. Enter New Media Password: commvault 

b. Confirm New Media Password: commvault 

c. Enter Old Media Password: Leave blank 

6. Click OK to set the password in the system properties. 

7. Click the X in the Control Panel screen to exit and return. 

 

Setting a Media Password – Storage Policy 

1. Log in to the CommCell® Console. 

2. From the CommCell Browser section, expand Storage Policies. 

3. Right click Basic Disk (MA) and select Properties. 

4. From the Storage Policy Properties: Basic disk (MA) window, click the Advanced tab. 

5. Check the box to Enable Storage Policy Level Media Password and enter the following information: 

a. Check box to enable Change Media Password 

b. Enter New Media Password: Student!23 

c. Confirm New Media Password: Student!23 

d. Enter Old Media Password: Leave blank 

6. Click OK to set the password on the storage policy. This will override the CommCell level password for this policy.    

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell Console. 

• Configured In-Line encryption. 

• Configured copy-based encryption. 

• Configured Hardware encryption. 

• Set a Media Password for the CommCell and a Storage Policy. 
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MODULE 2 – STORAGE ADVANCED CONFIGURATIONS 
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Disk Libraries 

Lab 2-1 Configuring Disk Library Advanced Options 

Once the Disk libraries are created, you can begin to configure storage options. In this lab you will complete the following 

tasks: 

• Log in to the CommCell® Console. 

• Set a low space watermark. 

• Configure mount Path Usage. 

• Set Threshold for Managed Disk Space. 

• Hide a Decommissioned Disk Library. 

• Set Space Allocation for a Mount Path. 

• Run Mount Path Validation. 

• Move a Mount Path. 

• Run Disk Library Maintenance. 

If you are familiar with the Commvault CommCell Console Library configuration, you may configure Libraries on your own. 

If you are new to Commvault, you can follow the step by step directions listed below. 

Configure mount Path Usage 

1. Log in to the CommCell Console. 

2. From the CommCell Browser section, expand Storage Resources. 

3. Expand Libraries and right click Basic Disk (MA) and select Properties. 
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4. From the Library Properties for Basic disk (MA) window, click the Mount Paths tab. 

5. Note the default option to Spill and fill mount paths. Change the Mount Path Usage to Fill and Spill. 

 

Set Library Free Space Threshold and Threshold for Managed disk space 

6. Click on the Space Management tab. 

7. From the Space Thresholds section, change the Warning Watermark to 20%. Change the Low watermark to 

10%. 

8. From the Thresholds for Managed Disk Space section, change the Start aging when data occupied on disk 

is setting to 90%. Change the Start aging when data occupied on disk is setting to 75%. 

9. Click OK to retain the settings and close the Properties window. 

NOTE- This setting for Thresholds for Managed Disk Space only applies to libraries not using deduplication. 

 

Set Space Allocation for a Mount Path 

10. Expand the Basic Disk (MA) library and right click the [ea-2019-ma] D:\Vol1… mount path and select 

Properties. 

11. Click the Allocation Policy tab. 

12. Under the Space Allocation section, select Do not consume more than (radio button) and set the space to 

20GB. 

13. Click OK to set the space allocation settings. 

 

Hide a Decommissioned Disk Library 

1. Right click the Basic Disk (MA) library and select Properties. 

2. From the General tab, check the box for the Hide Library option. This disables and hides the library. 

3. Click OK to close the Properties window. 

4. From the Ribbon Bar menu at the top of the CommCell console, click the Storage tab. 

5. From the Storage tab, select the Media Management option. 

6. From the Media Management Configuration window, Service configuration tab, scroll to the Show Hidden 

Libraries parameter and change the value to 1. Hidden libraries will now show in the Libraries view, though still 

disabled. If the library does not show, click to highlight the Libraries entity and use F5 to refresh. 

7. Click OK to close the Media Management Configuration window and set the configuration. 

8. Right click the Basic Disk (MA) library and select Properties. 

9. From the General tab, uncheck the box for the Hide Library option.  

10. Click OK to close the Properties window. 

 

Run Mount Path Validation 

1. Expand the Basic Disk (MA) library.   
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2. Right click the [ea-2019-ma]D:\Vol1… Mount path and select Validate Mount Path. 

3. From the Validate Mount Path popup window, change the File count option to 2. Click Ok to start the Mount 

Path validation job (this will take several minutes to run). The window will close and when the test is complete 

there will be a popup on the screen with the results.  

4. When the result window appears, view the details, then click OK to close the popup window. 

Move a Mount Path 

5. Expand the Basic Disk (MA) library.   

6. Right click the [ea-2019-ma]D:\Vol1… mount path and select Move Mount Path. 

7. From the Move Mount Path popup window, enter the following information: 

a. Select Source MediaAgent: Leave default 

b. Source Path: Leave default 

c. Destination Path, MediaAgent: ea-2019-ma 

d. Local Path (Radio button): E:\ 

8. Click OK to move the Mount Path. 

9. Click the Job Controller tab to view the progress for the job. 

10. From the CommCell Browser, Highlight the Libraries entity and use F5 on your keyboard to refresh the libraries. 

Expand Basic Disk (MA) and note the new location for the mount path. 

 

Run Disk Library Maintenance 

11. Right click the Basic Disk (MA) library and select Disk Library Maintenance. 

12. From the Disk library Maintenance window, check the box for Analysis for Mount Path E:  

13. Click OK to Run the maintenance task. This will indicate how fragmented the Mount Path(s) are. You can run the 

Library and Drive Report for results. 

 

At the end of this lab you will have completed the following items: 

• Set a low space watermark. 

• Configured mount Path Usage. 

• Set a Threshold for Managed Disk Space 

• Hide a Decommissioned Disk Library. 

• Set Space Allocation for a Mount Path. 

• Run Mount Path Validation. 

• Moved a Mount Path. 

• Run Disk Library Maintenance. 
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Deduplication 

Lab 2-2 Configure Global Deduplication with Partitions 

A global deduplication policy can accept data from multiple Storage Policies allowing deduplication across policies by 

sharing a common deduplication building block. In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Create a Disk Library. 

• Create a Global Deduplication Policy. 

• Configure an operation Window for pruning. 

• Configure and run a Dedupe Data Verification job. 

If you are familiar with the Commvault CommCell® Console and deduplication policy configuration, you may create and 

configure policies on your own. If you are new to Commvault, you can follow the step by step directions listed below. 

Add a Disk Library  

1. In the CommCell® Browser window, expand Storage Resources. Right-click on the Libraries entity and 

select Add then Disk Library…  

2. From the Add Disk Library popup window, enter the following information: 

a. Name: 20TB NAS 

b. MediaAgent: ea-2019-ma (Dropdown list) 



V11 FR22 Commvault Professional Advanced Lab Activity Guide March 2021 

 

Page 37 of 61  Commvault® Education Services 

3. Select Network Path and click the Credential drop-down list.  

4. Click the Create New button in the drop-down list. 

5. From the Create user credential window, enter the following information: 

a. Credential name: MountpathAccess 

b. User Name: company\student 

c. Password: student 

d. Owner: Master 

e. Description: Account for share access 

f. Click OK from the Create user credential dialog box to create the user credential. 

g. Folder: \\ea-2019-ma\Vol1 

6. Click OK to save and create the library. The 20TB NAS library appears in the Libraries list. 

 

Create a Global Deduplication Policy 

1. In the CommCell® Browser, expand the Storage Resources entity. 

2. Right-click Deduplication Engines and select New Global Deduplication Policy. 

3. From the Create Global Deduplication Policy Wizard, Select/Enter the following information. Click Next after 

each section is complete: 

a. Name: Global Deduplication Policy 

b. Library: 20TB NAS 

c. MediaAgent: ea-2019-ma 

d. Number of Partitions: 2 

i. Partition Information Partition 1: Click Choose Path 

1. MediaAgent: ea-2019-ma 

2. Partition Path: Click Browse, and navigate to Drive G: Click New folder 

a. Enter the name GlobalDDB-P1 then click OK 

3. Highlight the folder GlobalDDB-P1. Click OK to create the folder/path 

4. Click OK in the Partition Path screen to set the path for Partition 1 

ii. Partition Information Partition 2: Click Choose Path 

1. MediaAgent: ea-2019-cs 

2. Partition Path: Click Browse, and navigate to Drive F: Click New folder 

a. Enter the name GlobalDDB-P2 then click OK 

3. Highlight the folder GlobalDDB-P2. Click OK to create the folder/path 

4. Click OK in the Partition Path screen to set the path for Partition 2 

5. Click Next to continue the wizard 

e. Software Encryption: keep the default settings and click Next to continue. 
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4. Review the selections and click Finish to create the Global Deduplication Policy 

NOTE: The global Deduplication policy is listed under Storage Resources | Storage Pools. 

 

 

Configure Operation Window for Physical Pruning of Aged Data 

1. In the CommCell® Browser, expand the Storage Resources then MediaAgents. 

2. Right-click the ea-2019-ma MediaAgent and select All Tasks then Blackout Window. 

3. Click Add and enter the following information: (the software works on a 12-hour clock, you must configure a 

schedule up until 11:59 and a second schedule to start the next day.) 

a. Name: Data Pruning 

b. Operations: Data Pruning (Checkbox) 

c. Do not run intervals: Click Add 

i. Days of week: Monday – Friday 

ii. Do not run time interval: Start 8:00 pm, End 11:59 pm 

iii. Click OK to save to save the Time Interval 

d. Do not run intervals: Click Add 

i. Days of week: Monday – Friday 

ii. Do not run time interval: Start 12:00 am, End 07:00 am 

iii. Click OK to save the Time Interval 

4. Click OK to save the Operation Rule Details. 

5. Click Close to exit the Operation Window screen. 

 

Run Dedupe Verification and Edit the Schedule 

1. In the CommCell® Browser, expand the Storage Resources then Deduplication Engines. 

2. Expand Global Deduplication Policy/Primary_Global. 

3. Right click Global Deduplication Policy_Files_xx and select All Tasks then Run Data Verification. 

4. From the popup window, view the default settings and click OK to start the verification job. 

 

At the end of this lab you will have completed the following items: 

• Created a Disk Library. 

• Created a Global Deduplication Policy. 

• Configured an operation Window for pruning. 

• Configured and run a Dedupe Data Verification job. 
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Tape Libraries 

Lab 2-3 Sharing a Tape Library 

In many Commvault environments, tape is still used to manage offsite data storage and compliance copies. Often these 

tape libraries are SAN attached and shared by multiple MediaAgents. In this lab you will complete the following tasks: 

• Log in to the CommCell Console. 

• Share a Tape Library. 

If you are familiar with the Commvault CommCell® Console, you may create and configure storage on your own. If you are 

new to Commvault, you can follow the step by step directions listed below. 

Share a Tape Library using Expert Storage Configuration 

1. In the CommCell® tabs section select the Storage tab and click Expert Storage Configuration 

2. In the Select MediaAgents window, select ea-2019-ma, and ea-2019-cs. click the Add button to include 

both MediaAgents and click OK to close the window. 

3. Click OK to close the Information window. 

4. Click the Start button in the lower left of the Expert Storage Configuration window and select 

Detect/Configure Devices… from the list. 

5. In the Detect Library window, make sure that Automatically Create DDS Drivepools is selected. Leave the 

rest of the default settings under Device Type and click OK to scan for devices. 

6. When the scan completes, click OK to close the Information popup. Expand the Log and note that the library 

scanned the same drives connected to all selected MediaAgents (Dynamic Shared Library). Click Close to 

close the Log window. 

7. In the Libraries tab of Expert Storage Configuration, Right click the CommVault Scalar i6000 x library and 
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select Configure from the list. 

8. In the Configuration popup, select Library and all drives and click OK to configure the library. 

9. On the Discover Media Options window accept the default media type and click OK to continue. 

10. The new shared tape library is now configured, Click Start and select Exit from the list to close the Expert 

Storage Configuration tool. 

11. In the CommCell Browser window, expand Storage Resources then Libraries. The newly configured library 

(Commvault Scalar i6000 x) will appear. 

 

Lab 2-4 Tape Library Advanced Options 

In many Commvault environments, tape is still used to manage offsite data storage and compliance copies. Often these 

tape libraries are SAN attached and shared by multiple MediaAgents. In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Configure Virtual Mail slots. 

• Configure Appendable media. 

• Reset Containers and export locations. 

• Configuring Auto-Cleaning. 

• Set Overwrite Media options. 

If you are familiar with the Commvault CommCell® Console, you may create and configure storage on your own. If you are 

new to Commvault, you can follow the step by step directions listed below. 

Configuring Virtual Mail Slots 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Right click on Commvault Scalar i6000 x and select Properties. 

3. From the Library Properties for Commvault Scalar i6000 x window click the Media tab. 

4. Check the box for Virtual Mail Slot for Export. Enter the following information: 

a. Starts from Slot: 45 

b. Select Direction: And UP 

Configuring Appendable Media 

5. From the Media tab, ensure that the Mark Media Appendable option is checked. 

6. Change the Use Appendable media within to 30 day(s) of its last write time. 

Reset Container and Export Location for Returning Tapes 

7. From the Media tab, When Assigned Media Re-Appears in Library section, check the boxes Reset container 

and Reset export location. 

Configuring Auto-Cleaning 

8. From the Drive tab, Enable Auto-Cleaning section, enter the following information: 

a. On sense code:  check box 

b. Cleaning thresholds exceed: Leave unchecked 

c. Wait: 5 day(s) after last cleaning 

d. Continue using drive even if it needs cleaning, during restore: Leave unchecked 
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Set Overwrite Media options 

9. From the Media Usage tab, Overwrite Media section, enter the following information: 

a. When content verification fails: Check box 

i. Click OK in the popup box to acknowledge the read error warning. 

b. When it is from different CommCell: Check box 

c. Prevent use of tapes from a different backup vendor: Leave unchecked 

10. Click OK to close the Library Properties for Commvault Scalar i6000 x window. 

 

At the end of this lab you will have completed the following items: 

• Configure Virtual Mail slots. 

• Configure Appendable media. 

• Reset Containers and export locations. 

• Configuring Auto-Cleaning. 

• Set Overwrite Media options. 
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Tape Media Management 

Lab 2-5 Configuring Tape Media Management 

In many organizations, tape is still used to back up remote sites, and for offsite data storage for compliance. In this lab 

you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Configure spare media watermarks. 

• Create a spare media pool. 

• Configure and assign barcode patterns. 

• Export Tapes. 

• Prevent Tapes from Being Exported. 

• Define Export Locations. 

• Delete a Tape. 

• Run Tape Verification. 

• Mark Media Bad. 

• Configuring a VaultTracker® Export Policy. 

• Configuring a VaultTracker® Due Back Policy. 

If you are familiar with the Commvault CommCell® Console, you may create and configure storage on your own. If you are 

new to Commvault, you can follow the step by step directions listed below. 
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Create a spare Media Pool 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Expand Commvault Scalar i6000 x then Media By Groups.  

3. Right Click Media By Groups and select New Media Group then Spare Media Group. 

4. From the New Media Group window, enter the following information: 

a) Group Name: Alternate Scratch 

b) Priority: Low 

c) Watermark for Spare Media in the Pool:  

1. Low: 5 

2. High: Leave default setting 

d) Spare media Selection Criteria: Use most reused first 

e) Default Media Type: Virtual Tape 

 

Configuring and Assigning Barcode Patterns 

1. From the CommCell Console tab menu, select the Storage tab and click Media Management. 

2. From the Media Management Configuration window, click the BarCode Patterns tab. 

3. Under Add/Edit/Remove Pattern, click Add. 

4. From the Barcode Pattern window, enter the following information: 

a. Barcode Patter Name: Alternate Tapes 

b. Range: Check box 

i. From: CV0046WW 

ii. To: CV0056WW 

c. Click OK to create the barcode pattern 

5. Click OK from the Media Management Configuration window to close it. 

6. From the CommCell Browser window, Expand Storage Resources, then Libraries. 

7. Expand Commvault Scalar i6000 x then Media By Groups. 

8. Right click alternate Scratch and select Properties. 

9. From the Spare Group Properties window, select the Barcode Patterns tab. 

10. From the Available Patterns section, select Alternate Tapes and click Add to move it to the Selected Patterns 

window. 

11. Click OK to set the Barcode Pattern. 

 

Export Tapes 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Expand Commvault Scalar i6000 x then Media By Groups.  

3. Select the Default Scratch group and from the Browser Summary window, right click on Tape 100002WW and 

select All Tasks then Export. 
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4.  From the Export Media popup window, check the box for New Outside Storage Location. In the box, Enter 

DataCenter Storage for location. 

5. Click OK to set the location and move the tape to the I/E port (Mail Slot). Read the Export Media popup message 

and click OK to continue. 

6. From Media By Groups, Select the I/E Ports entity. The tape 100002WW will be in one of the slots ready to be 

removed from the library. 

 

Prevent Tapes from Being Exported 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Expand Commvault Scalar i6000 x then Media By Groups.  

3. Select the Default Scratch group and from the Browser Summary window, right click on Tape 100009WW and 

select Options then Prevent Export. 

4.  Click OK on the Confirm popup message. 

5. From the Prevent Export popup window, Select Infinite for the Expiration date, and click OK to prevent the tape 

from being exported. Note that the Icon for the tape changes to indicated that export is prevented. 

 

Define Export Locations 

1. From the CommCell Browser, expand Storage Resources then Locations. 

2. Right click Locations and select New Location.  

3. From the Export Location Details popup window, enter the following information. 

a) Location: Offsite storage Facility 

b) Type: Stationary 

c) Description: Tape storage facility 

4. Click OK to create the Location. 

 

Delete a Tape 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Expand Commvault Scalar i6000 x then Media By Groups.  

3. Select the Default Scratch group and from the Browser Summary window, right click on Tape 100002WW and 

select All Tasks then Delete. 

4.  Click Yes on the Confirm Delete popup message. 

 

Run Tape Verification 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Expand Commvault Scalar i6000 x then Media By Groups.  

3. Select the Default Scratch group and from the Browser Summary window, right click on Tape 100003WW and 

select All Tasks then Verify Media. 
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4.  Click OK on the Verify Media popup message. Note the message stating that the tape does not have a valid 

media label. Media labels are written the first time that a tape is mounted for a write operation. 

 

Mark Media Bad 

1. From the CommCell Browser, expand Storage Resources then Libraries. 

2. Expand Commvault Scalar i6000 x then Media By Groups.  

3. Select the Default Scratch group and from the Browser Summary window, right click on Tape 100003WW and 

select Options then Mark Media Bad. 

4. From Media By Groups, Select Retired Media. The bad tape will be listed in the group. 

 

Configuring a VaultTracker® Export Policy (Optional) 

1. From the CommCell Browser, expand Policies. 

2. Right click Vault Tracker Policies and select New Tracking Policy.  

3. From the Creation of Vault Tracker policy wizard, Enter the following information. Click Next when you have 

completed each screen: 

a) Enter Policy name and description: 

1. Policy Name: Weekly exports 

b) Select the policy type: Export Media 

c) Select the level of Storage Policy copy management: Select all 

d) Select the source locations: Select Libraries 

e) Select the media status:  

1. Assigned Media: Active, Appendable, Full 

2. And exists in: Check box 

3. Media Groups: All 

f) Select the criteria: 

1. Backup level: Check box, Select Include radio button 

2. Time Selection: Check box 

1. Select: Last Write, By Range older than 10 days 

3. Limit media count for export: move 5 media 

g) Select movement destination and tracking:  

1. Track Transit: Check box, Type Local Courier 

2. Destination: Select Export, select Offsite Storage Facility for dropdown list 

h) Review the summary: Review options and click Next. 

i) Create a schedule now for this policy: Yes 

j) Enter Schedule Name and its options:  
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1. Frequency: Weekly 

2. Schedule Name: Weekly Export Policy 

3. Start Time: 9:00 AM 

4. On these days: Check box for Monday 

4. Click Finish to create the tracking policy. 

 

Configuring a VaultTracker® Due Back Policy (Optional) 

5. From the CommCell Browser, expand Policies. 

6. Right click Vault Tracker Policies and select New Tracking Policy.  

7. From the Creation of Vault Tracker policy wizard, Enter the following information. Click next when you have 

completed each screen: 

a) Enter Policy name and description: 

1. Policy Name: Weekly Due Back 

b) Select the policy type: Due back for reuse 

c) Select the level of Storage Policy copy management: Select all 

d) Select the source locations: Select Libraries 

e) Select the criteria: 

1. Limit media count for due back: Leave unchecked 

f) Select movement destination and tracking:  

1. Track Transit: Check box, Type Local Courier 

2. Destination: Select Library, select Commvault Scalar i6000 x from dropdown list 

g) Review the summary: Review options and click Next. 

h) Create a schedule now for this policy: Yes 

i) Enter Schedule Name and its options:  

1. Frequency: Weekly 

2. Schedule Name: Weekly Due Back Policy 

3. Start Time: 9:00 AM 

4. On these days: Check box for Friday 

8. Click Finish to create the tracking policy. 

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell™ Console. 

• Configured spare media watermarks. 

• Created a spare media pool. 
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• Configured and assigned barcode patterns. 

• Exported Tapes. 

• Prevented Tapes from Being Exported. 

• Defined Export Locations. 

• Deleted a Tape. 

• Run Tape Verification. 

• Marked Media Bad. 

• Configured a VaultTracker® Export Policy. 

• Configured a VaultTracker® Due Back Policy. 
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MODULE 3 – STORAGE POLICIES 
 

Lab 3-1 Creating Storage Policies 

Once your storage is configured you can begin creating Storage Policies. Storage Policies provide a data path and 

retention for the selected subclient data. In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Create a Deduplicated Storage Policy. 

• Create a Synchronous copy. 

• Create a Selective copy. 

If you are familiar with the Commvault CommCell® Console, you may create and manage Storage Policies on your own. If 

you are new to Commvault, you can follow the step by step directions listed below. 

To create a Deduplicated Storage Policy 

1. In the CommCell® Browser, expand Policies. 

2. Right-click Storage Policies and select New Storage Policy. 

3. From the Create Storage Policy Wizard, enter the following information. Click Next when you have completed 

each screen: 

a. Storage Policy type: Data Protection and Archiving 

b. Storage Policy Name: Dedupe Data 

c. Select Storage Pool: Select Global Deduplication Policy 

d. Enter the streams and retention criteria: Leave default settings 
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e. Review your selections: Click Finish to create the policy 

4. Review the Summary window and click Finish to complete the setup of a Deduplication Enabled Storage 

Policy. 

5. In the CommCell® Browser, expand Client computers | ea-2019-cs | File System | defaultBackupset.  

6. In the Browser Summary window, right click on default subclient and select properties. 

7. In the Subclient Properties of default window, click the Storage Device tab. 

8. From the Storage Policy section click the drop-down list and select the Dedupe Data storage policy. 

9. Click OK to set the policy and close the properties window. 

 

Create a Synchronous copy 

1. In the CommCell® Browser, expand Policies then Storage Policies.  

2. Right-click on Dedupe Data storage policy and from the menu select All Tasks > Create New Copy.  

3. From the Copy Properties (Storage Policy: Basic Disk (MA)) window, enter the following information: 

a. Copy Details Window: 

i. Copy Name: Secondary Offsite copy 

ii. Storage Pool: Daily Offsite DASH Pool 

b. Retention Rules Window:  

i. Retain For: 60 Days and 2 Cycles 

c. Copy Policy Window: 

i. Selective Copy: Leave deselected 

ii. Backup Selection: Deselect All backups.  

iii. Backups on and After: Select the first day of the current month 

4. Click Finish to save the new Synchronous Secondary copy. 

 

Create a Selective copy 

1. In the CommCell® Browser, expand Policies.  

2. Right-click on the Dedupe Disk storage policy. From the menu select All Tasks then Create New Copy. The 

Copy Properties dialog box appears. 

3. From the Copy Details window, enter the following information: 

a. General Window: 

i. Copy Name: Selective Monthly Offsite copy 

ii. Storage Pools: Monthly Offsite pool 

b. Retention Rules Window:  

i. Override Retention: Check Box 

1. Retain For: 365 Days and 12 Cycles 

c. Selective Copy Window:  



V11 FR22 Commvault Professional Advanced Lab Activity Guide March 2021 

Page 50 of 61  Commvault® Education Services    

i. Automatically select full backups at frequency: Monthly Fulls 

ii. For monthly Full rule, the month starts on: 1 

iii. For each time period copy the: First full backup 

d. Copy Policy Window: 

i. Selective Copy: Check Box 

1. Select Full Backups at Frequency: Monthly Fulls 

2. For each Time Period Copy the: First Full 

ii. Backup Selection: Deselect All backups.  

1. Backups on and After: Select the First Friday of the current month 

iii. Source Copy: Check box 

1. Specify Source for Auxiliary Copy: Secondary Offsite Copy 

4. Click Finish to save the new Selective Secondary copy. 

 

 

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell® Console. 

• Created a Deduplicated Storage Policy. 

• Created a Synchronous copy. 

• Created a Selective copy. 

• Created a DASH Copy. 

 

Lab 3-2 Configuring Auxiliary Copy 

In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Configure an Auxiliary copy job. 

If you are familiar with the Commvault CommCell™ Console, you may create and Auxiliary copies on your own. If you are 

new to Commvault, you can follow the step by step directions listed below. 

Configure an Auxiliary copy job 

1. In the CommCell® Browser, expand Policies then Storage Policies.  

2. Right-click on Basic Disk (MA)storage policy and from the menu select All Tasks then Run Auxiliary Copy.  

3. From the Auxiliary Copy Job Options, enter the following information: 

a. General Tab: 

i. Select Source MediaAgent: <ANY MEDIAAGENT> 

ii. Copy Selection: Select a Copy – Select Offsite Copy from the dropdown list 

iii. Number of Readers: Allow Maximum 
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b. Job Initiation Tab: Run Immediate 

2. Click OK to start the Auxiliary copy job. 

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell® Console. 

• Configured an Auxiliary copy job. 

 

Lab 3-3 Storage Policy Tasks 

In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• View Jobs in a storage policy copy. 

• Change retention on a job. 

• Manually delete a job. 

• Disable and delete a Storage Policy. 

If you are familiar with the Commvault CommCell™ Console, you may manage Storage Policies and users on your own. If 

you are new to Commvault, you can follow the step by step directions listed below. 

View jobs in a Storage Policy Copy 

1. In the CommCell® Browser, expand Policies then Storage Policies.  

2. Expand Basic Disk (MA) storage policy and right click on Primary copy. select View then Jobs.  

3. Uncheck the box for Time Range and click OK to see list of jobs. 

Change Job Retention 

4. From the Jobs for Storage Policy-… tab, right click on an available job for the Mission Critical subclient 

backup and select Retain Job. 

5. From the Manual Retention End Time for Job xx window, click the Radio button Add and select 30 day(s) 

to the Retention Until date. Click okay to save the retention settings. 

 Note that the Icon has changed indicating the job has been manually retained 

6. From the Jobs for Storage Policy-… tab, right click the Mission Critical subclient backup from step 4 and 

select Change Retention. 

7. From the Manual Retention End Time for Job XX, select Do Not Retain Job. 

8. Click OK. 

Delete a job from a Storage Policy copy 

9. Right click on the Mission Critical backup job and select Delete Job. 

10. From the Delete Job popup window, under Do you want dependent jobs to be computed? select Yes. 

(Recommended) 

11. Click OK from the Delete Job window to delete the job. From the subsequent Delete Job popup window click 

OK to verify the deletion of any dependent jobs. 
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12. From the Enter confirmation text popup window, type erase and reuse media and click OK to complete the 

job deletion. 

 

Disable a Storage Policy for Backup 

1. In the CommCell® Browser, expand Policies then Storage Policies.  

2. Right click Dedupe Data storage policy and select Properties. From the Storage Policy Properties: Dedupe 

Data window, select the Associated Subclients tab. 

3. Click the Re-associate All button on the bottom right of the screen. 

4. From the Re-Associate Subclient(s) popup window, select Basic Disk (MA) and click OK. 

5. Click OK to re-associate subclients. 

6. Right click Dedupe Data storage policy and select Properties. From the Storage Policy Properties: Dedupe 

Data window, select the General tab. 

7. Check the box next to Hide and Disable Storage Policy for Backups. Click OK on the verification 

information window. 

8. Click OK to hide the storage policy. 

 

Show disabled storage Policies 

1. From the tab menu at the top of the CommCell console, click the Storage tab. 

2. From the Storage tab, select the Media Management option. 

3. From the Media Management Configuration window, Service configuration tab, scroll to the Show Storage 

Policies Disabled for Backup parameter and change the value to 1. Hidden Storage Policies will now show in 

the Storage Policies view, though still disabled. 

4. Click OK to close the Media Management Configuration window and set the configuration. You will see the 

storage policy again after going to the Storage Policies container and pressing F5 to refresh. 

5. Right click the Dedupe Data storage policy and select Properties. 

6. From the General tab, note that the policy is still disabled.  

7. Click OK to close the Properties window. 

 

Delete a Storage Policy  

1. In the CommCell® Browser, expand Policies then Storage Policies.  

2. Right click Dedupe Data storage policy and select All Tasks then Delete. Click Yes on the confirm Delete 

popup box. 

3. From the enter Confirmation text popup window, type erase and reuse media. Click OK to complete the 

storage policy deletion. 

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell® Console. 
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• Viewed Jobs in a storage policy copy. 

• Changed retention on a job. 

• Manually deleted a job. 

• Disabled and deleted a Storage Policy. 

 

 

 

 

 

MODULE 4 - MONITORING 
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Commcell® Console tools 
 

Lab 4-1 CommCell® Console Tools 

CommCell Console tools provide a way of monitoring your environment for potential issues. In this lab you will complete 

the following tasks: 

• Log in to the CommCell® Console. 

• View Deduplication Engine views. 

If you are familiar with the Commvault CommCell® console, you may Access views on your own. If you are new to 

Commvault, you can follow the step by step directions listed below. 

 

Deduplication Engine Views 

1. In the CommCell® Browser, expand Storage Resources then Deduplication Engines.  

2. Expand Dedupe Data Global Deduplication Policy, then Global Deduplication Policy_Files_xx. 

3. Select [ea-2019-ma] G:\GlobalDDB-P1… 

4. The Properties section displays information about the DDB partition including information on the last DDB backup 

time. 

5. This view also displays the response time of the database for queries and inserts. 

6. Additional information of the deduplication partition including graphs and statistics can be viewed in the details 

pane. 

6. The Graph displays unique and secondary blocks. Includes pending delete records. 
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At the end of this lab you will have completed the following items: 

• Log in to the CommCell™ Console. 

• View Deduplication Engine views. 

• Configure Metrics reporting 
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CommCell® Console Alerts 

Lab 4-2 Create and Manage Alerts 

In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• View and enable existing alerts. 

• Create alert with Email notification. 

• Create alert with Console notification. 

If you are familiar with the Commvault CommCell® Console, you may create and manage copies on your own. If you are 

new to Commvault, you can follow the step by step directions listed below. 

View and Enable Alerts 

1. From the CommCell® Console’s Ribbon bar click the Home ribbon tab then Alert.  

2. Scroll to view all of the available pre-built alerts. 

3. From the Alerts Window, navigate to the Data Aging is disabled for the last n days alert. Click the check box in 

the status column to enable the alert or click the Enable button. 

Add an Alert with Email Notification 

1. In the Alerts dialog box click Add and configure a new alert using the following information. Click Next as you 

complete each page: 

a. General Information:  

i. Display Name: Required updates 
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ii. Category: Software Updates 

iii. Type: Upgrade Client 

b. Entities Selection:  

i. Select: All clients 

c. Threshold and Notification Criteria Selection: Leave default Selections 

d. Notification Type(s) Selection:  

i. Email Tab: Check box Select [Email] for notification 

ii. Review additional options 

e. Token Criteria Selection: Leave default 

f. User(s) and Group(s) Selection:  

i. To: admin 

ii. Sender Name: Commserve 

iii. Sender Address: Cvadmin@company.com 

g. Security: Leave default 

h. Summary: View alert information and click Finish. 

2. The new Required Updates alert appears in the Alerts dialog box list. 

3. Click OK to exit. 

 

Add an Alert with Console Notification 

4. In the Alerts dialog box click Add and configure a new alert using the following information. Click Next as you 

complete each page: 

a. General Information:  

i. Display Name: Phase Failure 

ii. Category: Job Management 

iii. Type: Data Protection 

b. Entities Selection:  

i. Agent Type: Leave default 

ii. Association: Check the box for Client Group Infrastructure  

c. Threshold and Notification Criteria Selection:  

i. Check Box: Alert every 2 attempts (Phase Failure) 

d. Notification Type(s) Selection:  

i. Console alerts Tab: Check box Select [Console Alerts] for notification 

e. Token Criteria Selection:  
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i. Select the following rules: STORAGE POLICIES USED, and Equals, then type CommServeDR 

in the blank field 

f. User(s) and Group(s) Selection:  

i. To: Leave default 

g. Security: Leave Defaults 

h. Summary: View alert information and click Finish. 

5. The new Phase failure alert appears in the Alerts dialog box list. 

6. Click OK to exit. 

 

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell® Console. 

• Viewed and enabled existing alerts. 

• Created alert with Email notification. 

• Created alert with Console notification. 
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CommCell® Console Reports 

Lab 4-3 Configure CommCell® Console Reports 

Reporting is a very important part of monitoring your CommCell’s health. In this lab you will complete the following tasks: 

• Log in to the CommCell® Console. 

• Create and run a Job Summary report. 

• Create and Schedule a Data Retention Forecast and Compliance report. 

• Create and Save a CommCell Configuration report. 

If you are familiar with the Commvault CommCell® console, you may create and manage reports on your own. If you are 

new to Commvault, you can follow the step by step directions listed below. 

Create and Run a Report 

1. From the CommCell® Console Ribbon bar click the Reports tab and select Job Summary.  

2. Click the Job Summary (CommCell Console) entry and enter the following information: 

a. General Tab: 

i. Select: Backup (Radio button) and select Backup from the dropdown list 

b. Computers:  

i. Keep Default: All computers, all agents 

c. MediaAgents: 

i. Include all MediaAgents: Leave default 

d. Storage Policies: Check to include all policies 
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e. Selection:  

i. Diagnostic: Failure Reason 

ii. Contents: Failed Objects 

iii. Storage: MediaAgents 

f. Options: 

i. Backup Types: All 

ii. Job Status:  Deselect All, Check Failed, Completed 

g. Time Range: Last 3 Days 

h. Output:  

i. Output format: HTML 

3. At the bottom of the Report Selection dialog box, click on Run. After a few moments, the Backup Job Summary 

Report appears. (If an error pops up stating “No data was found for the selected criteria” it means there were no 

failures for the time period selected) 

4. View the report then close the browser to complete this activity. 

5. Close the Report Selection page. 

 

Create a report and Schedule 

1. On the CommCell® Console Ribbon bar, select the Reports tab.  

2. From the Other Reports icon, use the drop-down menu and select Forecast.  The Report Selection dialog box 

appears with the Data Retention Forecast and Compliance report highlighted.  

3. Review the available options for this report and when finished, click on the Schedule button. The “Schedule 

Details” dialog box appears. 

4. Configure the report using the following information: 

a. Schedule Pattern:  

i. Schedule Name: Weekly forecast 

ii. Select: Weekly, Friday, 8:00 AM 

b. Report Details:  

i. Deselect: Show prunable data 

ii. Select: Show unprunable data 

c. Notification:  

i. Available Users: Admin, Master. Use the > to move each to the Users to be notified column 

5. Click OK to schedule the report.  Click OK on the information – Report Scheduled Successfully window. 

6. In the Report Selection dialog box click Close to exit the dialog box. 
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Create a Report and Save as a Custom Report 

1. From the CommCell® Console Ribbon bar, select the Reports tab and then Other Reports. 

2. Select Configuration from the pull-down menu. The Report Selection dialog box appears.  

3. Configure the report using the following information: 

a. General: 

i. Verify Selection: CommCell, Alerts, User/User Groups 

b. MediaAgent:  

i. MediaAgents: Include All MediaAgents 

4. At the bottom of the Report Selection dialog box, click on Save As. The Save As dialog box appears. 

5. In the Save As dialog box enter “New CommCell Report” as the report name.  

6. Click OK to save the report.  

7. A pop-up dialog box appears noting the report was saved successfully. Click OK. 

8. In the Report Selection dialog box click Close to exit the dialog box. 

9. In the CommCell® Browser, expand Reports then My Reports.  

10. Select General. In the Summary window the saved “New CommCell Report” configuration report will be listed. 

11. Right-click on the new report and select Run Immediately. After a moment, the CommCell Configuration Report 

will appear. 

12. Review the report. 

13. Close the browser to complete this activity. 

 

 

At the end of this lab you will have completed the following items: 

• Logged in to the CommCell® Console. 

• Created and run a Job Summary report. 

• Created and Scheduled a Data Retention Forecast and Compliance report. 

• Created and Saved a CommCell Configuration report. 

 

 

 

 

You have completed the labs for the Commvault Professional Advanced course. Congratulations! 

 


